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• Open and process 1D and 2D NMR data 
• Multiplet analysis for 1D 1H NMR 
• Assign 1D peaks to a structure 
• Assign 1D and 2D spectra 
• Report analysis results 
• Basic handling of multiple spectra 
• Predict, assign and verify
• LC/GC-MS data processing

Note: This tutorial covers only the NMR, NMRPredict, and MSChrom Mnova plugins



Installation and Activation of 
Mnova, and General Setup

You will need to have Mnova Suite license



I n s t a l l a t i o n

• Download and install Mnova from  
www.mestrelab.com

• Choose File > Help > License 
Manager to open the License 
Manager dialog 

• The status of the license 
activation of the plugins you’ve 
installed are listed. You can hover 
the cursor on the State icon, and 
it will display the status of that 
plugin 

• To activate the plugins, click the       
button to open the Registration 
Wizard (see next page)

The Host ID for this computer Location of the license file

License issue date

Mnova plugin names

Days before License expires, and 
Updates and Support Package 
expires

http://www.mestrelab.com/


I N S TA L L AT I O N

• If you have a license file (.lic or .zip), click Install to open it  

• If you don’t have license files, click Evaluate to apply for 45-day free trial licenses online, or 
otherwise click Buy to purchase a license

• To manage campus/site/concurrent licenses, click here
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https://resources.mestrelab.com/how-to-manage-the-campus-or-floating-licenses-with-mlicadmin/


P R E F E R E N C E S

Choose File/Preferences. In the NMR > Import Tab, check 
Baseline Correction 1D so that baseline correction is 
automatically performed when you open an NMR spectrum. 
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Note: Automatic Baseline Correction uses the default 
algorithm of “Bernstein Polynomial  with order of 3”, 
or the one that you used previously.  Be aware of the 
default baseline algorithm it uses. 
We don’t recommend checking the Baseline 
Correction for 2D NMR because this may make 
manual phasing of 2D NMR sluggish.  You can apply 
baseline correction manually after the phase has 
been corrected. 

Tip: There are many other options and settings that 
you can change in the Preferences Dialog. 

Shortcut for Preferences



Choose File/Preferences. In the Drawing Tools tab, 
change the resolutions for Image Exporting and Image 
Copying to numbers similar to something shown below. 

P R E F E R E N C E S
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The resolution for Image Exporting is used when you 
choose File > Save As and save the selected objects in 
Mnova as graphical image files. 

The resolution for Image Copying is used when you 
copy selected objects in Mnova and paste them into 
other applications. 

*Note: Increasing the graphics resolution can increase 
the size of the PDFs generated by Mnova.  If you are 
mostly saving the reports in PDFs and want to conserve 
the disk space, skip this step. 

Shortcut for Preferences



S E T U P

• In the View Ribbon, check the Pages, Full View, Parameters, and Data Browser 
Views

• Dock and arrange them as shown below
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Full View 

Pages 
View 

Data Browser
Document Header

The current Document View

Click here to 
minimize the ribbon

Click here to switch 
the panels or tables



S E T U P

• Click “+” in the Data Browser, navigate to the 
directory where your NMR or LCMS data are located, 
and click OK to add it. 

• Click the ‘Settings’ button to turn on the display of 
metadata, date and time, and enable sorting 
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D ATA  F I L E  E X A M P L E S

If you need to download example datasets for practice, such as 1D and 2D NMR, 
LC/MS data, and the structure of quinine, choose File > Help > Download Examples
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Basic 1H NMR Processing

You will need to have an Mnova NMR license for this section



1H NMR (600 MHz, DMSO-d6) δ 12.25 (s, 1H), 
7.19 (d, J = 7.8 Hz, 2H), 7.10 (d, J = 7.9 Hz, 
2H), 3.62 (q, J = 7.1 Hz, 1H), 2.41 (d, J = 7.2 
Hz, 2H), 1.80 (dt, J = 13.5, 6.8 Hz, 1H), 1.34 (d, 
J = 7.1 Hz, 3H), 0.85 (d, J = 6.7 Hz, 6H).

• Open the raw data
• Pre-process the FID: apodize, zero fill, linear predict, 

etc. 
• Fourier transform
• Phase correct and baseline correct
• Chemical shift reference
• Peak pick, integrate, multiplet analysis
• Peak assignment
• Report and publish

P R O C E D U R E
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Note: Most of these steps are done automatically by Mnova.  However, you retain full control at all times.



P R O C E S S I N G

• Use ‘File > Open’ to open one spectrum or drag and drop one or multiple data from 
the Data Browser onto the Mnova canvas

• When a raw data is brought in, it is automatically processed based on the original 
processing parameters and Mnova preferences
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P R O C E S S I N G

• If needed, use tools in NMR/Processing Ribbon to adjust any processing 
parameters to re-process the spectrum 

• Or use the Advised Processing to reprocess the spectrum with suggested 
parameter settings 

• The processing parameters can also be modified or imported using the Processing 
Template.  
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• Go to View/Tables… Parameters to view the acquisition 
parameters

• Press Report to report the parameters as a text box on the page

Use the green handles to move, 
rotate, and resize the text box. 
Every object in Mnova can be 
relocated and resized

P R O C E S S I N G
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Use Processing Template to visualize the applied processing parameters, and report the 
processing parameters as needed.   The parameters can also be saved as a template for 
processing similar spectra. 

P R O C E S S I N G / R E P O R T I N G

Apodization
Stanning: 8

Zero Filling and LP
Spectrum Size: 65536

Fourier Transform
Protocol: None
Swap Halves: true
Mirror Image: true
Real FT: false

Phase Correction
Method: Regions Analysis
PH0: -141.50 °
PH1: -4.39 °

Baseline Correction
Method: Bernstein 

Polynomial Fit
Polynomial Order: 3
Exclude Cuts and Blind 

Regions: false
Run on a Region: false

Reference
Old shift: 7.236 ppm
New shift: 7.260 ppm
Autotune: false



• Press           for phase 
correction if peaks are not 
symmetric*

• Press           for baseline 
correction if baseline is not 
zero*

• Press           to calibrate the 
chemical shift reference if 
the solvent or TMS peak is 
not at the correct ppm

Note: Using these tools is equivalent to applying the corresponding options in the Processing Template Panel. 

P R O C E S S I N G
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or



P R O C E S S I N G

• Regions Analysis: good for most cases 
• Global: good for spectra without 

negative and/or big solvent peaks
• Selective: DEPT type of spectra with 

negative peaks
• Metabonomics: spectra with big 

solvent peaks
• Whitening: usually for 2D



P R O C E S S I N G

• Set the Pivot Point
• PH0: zero-order correction (left 

mouse button + scroll up/down)
• PH1: first-order correction (right 

mouse button + scroll up/down)
• Ctrl + scrolling: fine tuning



P R O C E S S I N G

• Choose a function to model the baseline:
• (Bernstein) Polynomial Fit: small base errors
• Splines or Ablative: for medium base errors
• Whittaker: For more serious base errors. Use 

with caution and make sure the bases of 
peaks are not compromised. Use appropriate 
parameter values to tune the fit

• Multipoint B.C.: Manually define base points 
and choose a fitting algorithm



P R O C E S S I N G

• Manually or automatically pick base points   
• Double click on a basepoint again to 

remove it 
• Choose the best algorithm to fit the 

basepoint to a baseline 
• Click Apply to deduct the baseline from 

the spectrum 



A N A LY S I S
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• Graphic Reference for 2D NMR
(two clicks)

• Reference by entering the value



A N A LY S I S
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• Applies to multiple spectra of the same sample acquired under the same conditions
• Open all spectra in the same document  
• Reference the H-1 spectrum manually first 
• Next choose Reference/Absolute Reference to reference all other spectra (1D or 2D)



D I S P L AY  O P T I O N S
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Zoom in/Zoom out (or press Z) *
Zoom out
Full spectrum (or press F)
Manual Zoom in to defined ppm range
Pan spectrum (or press P)**
Expansion – click and drag to draw an inset (or press E)
Previous Zoom
Next Zoom

Fit to Highest Intensity (or press H)
Fit to highest compound peak
Increase Intensity (or rotate mouse wheel)
Decrease Intensity (or rotate mouse wheel)
Crosshair Cursor (or press C) for measuring J-couplings
Cut (or press X) to hide parts of the spectrum

Press E, then click and drag to define the range for the inset

*Press Z multiple times to toggle between horizontal/ 
vertical/ box zoom
** Press P multiple times to toggle between free/ horizontal/ 
vertical panning



Tip: Use the Save tool to save the 
properties to a file, and distribute it 
to other users for consistent display 
and reporting.

• Right click on the spectrum and choose Properties to open the Properties dialog
• Change the options as needed and click Apply to verify the effects. 
• Click on Set as Default to save settings for spectra opened in the future

D I S P L AY  P R O P E R T I E S
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• For 2D NMR, there are extra properties to choose, such as: 
• Legend

• Color Palette

• Plotting Method

• Contours

Tip: You can set a line width for 2D contours 
independent of that for 1D curves.

D I S P L AY  P R O P E R T I E S
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• If available, 1D spectra in the same document are automatically attached to 2D NMR when 
opened 

• To achieve this manually, highlight a 2D spectrum, then drag a 1D from the Pages panel to 
attach it to the 2D as an external trace

Change the Y intensity of the traces: Place the cursor on the trace 
and scroll the mouse wheel or click Ctrl+Shift+arrow keys.
Move the baseline of a trace: Shift + mouse wheel 
Change the space of the attached 1D’s: Right click on the 2D 
spectrum and open the Properties dialog.  

Drag and drop

A N A LY S I S
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Basic Analysis of 1H NMR

You will need to have an Mnova NMR license for this section



1H NMR (400 MHz, CDCl3) δ 8.65 (d, J = 4.5 Hz, 1H), 7.98 (d, J = 9.2 
Hz, 1H), 7.49 (dd, J = 4.5, 0.7 Hz, 1H), 7.33 (dd, J = 9.2, 2.7 Hz, 1H), 
7.24 (d, J = 2.7 Hz, 1H), 5.75 (ddd, J = 17.1, 10.3, 7.6 Hz, 1H), 5.51 
(d, J = 4.4 Hz, 1H), 5.04 – 4.85 (m, 2H), 3.90 (s, 3H), 3.53 – 3.39 (m, 
1H), 3.37 (dt, J = 5.5, 2.5 Hz, 1H), 3.14 (td, J = 7.5, 4.3 Hz, 1H), 3.08 
(dd, J = 13.8, 10.2 Hz, 1H), 2.78 – 2.55 (m, 2H), 2.39 – 2.13 (m, 1H), 
1.81 (q, J = 3.3 Hz, 1H), 1.71 (tdt, J = 12.5, 8.2, 2.6 Hz, 2H), 1.63 –
1.54 (m, 1H), 1.54 – 1.42 (m, 1H).

• Mnova provides two approaches to multiplet analysis:
• Fully automatic: peak picking, integration, and multiplet analysis all achieved in a single 

click, with peaks deconvolved using GSD*
• Manual: click and drag to pick each multiplet interactively

• In either case, you can refine the results interactively, and report them in the selected 
journal or patent formats

A N A LY S I S  A N D  R E P O R T I N G
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*See more details about GSD

http://mestrelab.com/resources/gsd


30

Total number of nuclides 
from all the multiplets and 
the number of protons in 
the molecule (if present)

The number of 
nuclides (NN) of the 
multiplet

Normalized integral 
of the multiplet

*Depending on the Calculation Method in the Multiplet Analysis Options, the integral of a multiple is 
calculated as the sum of the deconvoluted peaks or the sum of the data points within the range. 

• Click        to perform automatic multiplet analysis
• By default, Mnova does the following automatically:

• Picks peaks using GSD* (if no peaks were picked) and classifies their types (compound, 
solvent, impurity peaks, etc.), all of which is controlled via Peak Picking Options

• Groups picked peaks into multiplets and fits them to J-coupling patterns, then calculates their 
integrals, all controlled by Multiplet Analysis Options

• Estimates the total number of nuclides (NN), and normalizes the integrals for each multiplet*



A N A LY S I S
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Click and drag to define the 
integration region and peak 
picking threshold

• Manual Multiplet Analysis offers more control to the user (J is the shortcut key)
• Zoom into each multiplet, click and drag to define the following: 

• Peak picking threshold
• Integration region

• Mnova picks the peaks in the region, fits them to a J-coupling pattern, and defines the 
multiplet in the same way as in automatic multiplet analysis



• Double click on a multiplet label to open the Multiplet Manager  
• Use it to inspect and change the properties of the multiplets, including the normalization of the 

integrals, J-coupling patterns and constants, etc. 

Navigate to the 
Previous/Next multiplet

Delete the current multiplet

Add/Delete multiplet peaks 

Properties of the current 
multiplet

Number of protons in the 
molecule (if present)

Integration region of the 
multiplet

The number of protons this 
multiplet corresponds to. 
Changing this number affects 
only the current multiplet

Normalized integral of the 
multiplet. Changing it affects 
all multiplets

Absolute integral of the 
multiplet

Use this tool to simulate 
the multiplet

Use this tool to measure J 
constant manually

A N A LY S I S
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Full View: Display the whole spectrum and zoom-in area. Drag the purple box to move to other multiplets.  Choose View/Full 
View to open the Full View panel, which can be docked as shown

Manual multiplet analysis: Press J, then click and 
drag across peaks to define the range and peak 
picking threshold

Multiplet Manager shows the properties of the 
currently picked multiplet. (Double click on a 
multiplet label to open it)

Multiplet label: Click on 
it to set it as the current 
active one

Multiplet bar: Use it to 
split a multiplet into two,  
or to change its range

A N A LY S I S
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Show Peak Curves to display the 
GSD peaks (displayed in blue)

Drag this white box to split the multiplet 
into two distinct multiplets

Tip: You can also change the display of the deconvolution peak 
curves in Properties Dialog > Peaks > Curve tab

A N A LY S I S
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A N A LY S I S
3
5



Use the simulation tool in the 
Multiplet Manager to simulate 
the multiplet and compare

Go to Properties/ 
Multiplets and turn on 
the ‘J’s Tree’ option

A N A LY S I S
3
6



• Override the analysis results for a multiplet in Multiplet Manager
• In this example, the multiplet was estimated to be a “qdd”.  The simulated multiplet does 

not agree with the observed spectrum, and hence it is wrong
• Select “m” from the ‘Class’ pull-down menu to override it 

Choose “m” from the 
drop-down menu to 
override the results

Use  the simulation tool 
to simulate the 
multiplet and compare

A N A LY S I S
3
7



 If a  peak is assigned incorrectly to a group, use the Add Multiplet 
Peak       tool in the Multiplet Manager to reassign it to a different 
group

 Click on the pink wedge on a peak and drag it to the multiplet label
 In the following example, two peaks were reassigned, forming a 

different pair of doublets:

A N A LY S I S
3
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• Click on Report Multiplets to report the results in a 
particular journal format

• To change the journal format: Go to View/ Tables/ 
Multiplets to display the Multiplets Table

• Then click on Setup Report

Tip: From the Multiplet Table, click Copy Multiplets and then paste the text to your document.  Click on Copy Table and then paste 
the spreadsheet to your document.  The table can be customized using Setup Table.

R E P O R T I N G
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A N A LY S I S
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*See more details about GSD

 When peak-picking         or multiplet analysis        is 
performed, Mnova does a global spectral deconvolution 
(GSD) by default, then uses the deconvolved peaks in the
peak-picking results*

 Choose to display the deconvoluted peaks (blue) and the 
residuals (cyan), Peak Table using the relevant tools

To turn on/off the 
GSD peaks

http://mestrelab.com/resources/gsd


• The peak picking and multiplet analysis described previously 
both give integrals of deconvolved peaks or multiplets.  
However, in some situations, e.g., polymer or complex 
mixtures, peak- or multiplet-based integration is impossible, 
and we will use the direct integration tools 

• By default, the integrals from these tools are “Sum-based”, 
i.e., by summing up each data point within a range. The results 
have nothing to do with the peak-picking results* 

• Both automatic and manual integration tool are provided 
• To normalize an integral, double click on the integral curve to 

open the Integral Manager, and set its Normalized value to 1 

41

Double click

Enter the 
normalization value

*Depending on the nature of the 
spectrum, different integration 
options can lead to significantly 
different results. Be aware of the 
options you are using.  



A N A LY S I S
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• The integration results can be displayed in an Integrals 
Table, and the results can be reported from there 

• Browse, delete, change, split integrals interactively if 
needed

• To interactively change or split an integral: 

Hover the cursor on the 
integral bar, drag the central 
white box to a basepoint and 
release to split the integral

Split Change

Drag the left 
green box to the 
right to skip the 
CHCl3 peak



• When peaks have irregular shapes, Peaks-based multiplet analysis may give significantly 
different integration results than regular Sum-based integration

• In the example below, Peaks-based multiplet analysis extracts the regular peaks but 
ignores the irregular ones (that are usually) due to exchangeable protons

A N A LY S I S
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(GSD) Peaks-based integration when running multiplet analysis 



• When Sum-based integration is performed, all peaks are included by adding point 
intensity by point intensity within the integration region

• Depending on the goal of the analysis, one must choose the appropriate integration 
method

A N A LY S I S
4
4

Sum-based integration



Combine Sum-based integration         and multiplet analysis

• If direct integration is performed prior to automatic multiplet analysis, the integration 
results (regions and integrals) will be preserved by the automatic multiplet analysis 
routine

• Compare the results below with those in the previous two slides: 

A N A LY S I S
4
5



More Advanced Analysis 
of 1D and 2D NMR

*You will need to have Mnova NMR and NMRPredict licenses for this 
section



Tips: 
1. Choose Prediction Options to change settings
2. You can turn on/off atom numbers by right-
clicking on the structure and choosing Properties
3. You can open the Prediction Table to list the 
predicted shifts and J-couplings, and manually 
change them

A separate license for Mnova NMRPredict 
Desktop is needed.

P R E D I C T I O N
4
7

• Open a new document (File/New) or a new page 
(Edit/Create New Page)

• Copy a structure from ChemDraw or ChemSketch, then paste 
to Mnova, or open a .mol, .cdx, or .sdf file; or you can also 
sketch a structure in Mnova using the Molecule Ribbon

• Select a spectrum, and click the appropriate icon from the 
Predict ribbon



• Open a 1H (or 13C) spectrum on a new page
• Copy the structure from ChemDraw or ChemSketch
• Go to Analysis/Predict and Compare. The predicted spectrum is 

stacked with the experimental one for visual comparison

P R E D I C T I O N
48

You can drag the label of a 
predicted peak to change 
its chemical shift.  You can 
also change the predicted 
J-couplings in the 1H 
Prediction Table 

To delete the predicted 
spectrum, open the 
Stacked Item Table from 
the Stacked Ribbon, and 
use the ‘Delete’ tool 
therein to delete it 



A S S I G N M E N T S
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Pages View 
allows you to 
easily navigate 
among spectra 

Full View allows you to easily 
navigate among peaks

The structure(s) is 
shared for all 
“linked” spectra 
and assigned 
peaks are color 
coded

The assignment 
results are listed 
here.  You can 
delete or change 
assignments here, 
and choose which 
spectra should be 
“linked”

Click on a peak top or a multiplet 
label, and then on an atom to assign 
it

Tip: Don’t mix spectra from different samples in the same document. Don’t open the same structure multiple times. Instead, use the Compounds Table to 
report the structure to the spectrum when needed. You can copy/paste and display multiple spectra side-by-side on the same page.

The structure can 
be shown on the 
spectrum plot or 
in the Molecule 
Window

Mnova provides a very convenient layout and a set of tools for assigning peaks from multiple 
spectra to the structure



Tip: After the assignment, the atom label is changed to green. The multiplet label shows the atom label.  The multiplet label can be turned off by 
unchecking the Analysis/Multiplet Analysis/Multiplets Boxes.

 Press the A key (or choose Assignments/Manual Assignment) to enter Manual Assignment mode 

A S S I G N M E N T S
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2. Then click on the atom the 
atom to assign it to the multiplet1. In Manual assignment 

mode, first click on the 
multiplet label. The cursor 
will change to

3. Assignment label is 
displayed

Assignments suggestions are 
highlighted by a suitable color code

Assignments  are automatically  
transferred to the other 1D and 2D 
spectra in your document



• Open a 1H (or 13C) spectrum in a new page, do multiplet analysis or peak picking as usual
• Copy a structure from ChemDraw or ChemSketch
• Go to Analysis/Predict & Compare. The predicted spectrum will be stacked with the 

experimental one for visual comparison
• Switch to Superimposed Mode so you can assign the multiplets/peaks using the predicted 

peaks as a guide 

A S S I G N M E N T S
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Make sure the experimental spectrum 
is the active one

In Manual Assignment mode, click on a 
multiplet label and then on an atom to 
make the assignment 

Blue: predicted peaks
Red: observed peaks



• Open a 1H spectrum in a new page, and copy your structure from ChemDraw or ChemSketch
• Select Analysis/Assignments/Automatic Assignment. Mnova will do multiplet analysis (if not 

done yet), predict the 1H spectrum, and automatically assign the 1H peaks
• Automatic assignment is also available for 2D HSQC and 13C spectra

A S S I G N M E N T S
5
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• In the Assignment 
Ribbon, press the 
NMR Assignments 
tool to open the 
Assignments Table

• The Table and the 
structure are 
correlated: you can 
click on a row to 
highlight the atom 
(and its assigned 
peak), or vice versa

A S S I G N M E N T S
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Tip: right-click on an atom and go to Edit Atom Data from the pop-up menu to change its label. Changed labels will  be used in the 
Assignments table and other relevant reports. 



• Assign the 1D 1H peaks, and 
then assign HSQC cross 
peaks, or vice versa

• Assignments in one spectrum 
are carried over to all other 
spectra in the same 
document. All spectra in the 
same document are 
“correlated” by default

• To assign atoms in a HSQC, 
press the “A” key to enter 
Assignment mode. Click on 
an atom in the molecular 
structure. Next click on the 
cross peak to assign it*

54

*By Default, Mnova automatically groups one or multiple 2D peaks into a “multiplet”, similar to 1D NMR. When needed, it is very 
straightforward to manually change the size or center of a 2D multiplet, or to add a new one. 

1H assignments from 1D 
spectrum or HSQC. You 
can move a 1D assignment 
label to adjust its chemical 
shift

13C assignments from 
HSQC



• In Assignment mode, click the center of an HMBC peak shown below. Then click on H7 while holding the Alt key*
• In the Assign pop-up window, choose the options as shown below. Click OK to assign the peak to both H7 and C1 
• COSY- and NOESY-type spectra can be assigned in a similar manner

A S S I G N M E N T S
5
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1. Click the center of 
the peak in 
assignment mode

2. While holding Alt 
key, click H7

3. Choose ‘Keep Original’ 
for F2 to use the 1D 1H 
shift (instead of that from 
2D). Choose C1 for F1, 
and choose ‘Keep 
Original’ to use the 1D 
13C shift

*Since chemical shifts from 1D NMR are usually of higher resolution than 2D, we recommend you to use 1D shifts whenever possible. 
To access such choices, press and hold the Alt key while assigning a peak 



For a structure on the canvas, in the Molecule Window, or in the Compounds Table, you can choose 
Graphical Props Tool to choose display properties related to the assigned 2D NMR connectivity as 
shown below: 

*Don’t open the same structure multiple times. Instead, use the Compounds able to report the structure to the pages where needed

A S S I G N M E N T S
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Use the check boxes in the Assignment table to toggle the display of arrows

A U T O M AT I O N / S C R I P T I N G
5
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Uncheck here if you want to hide 
all the COSY connectivities related 
to H-32’’ on the structure



• Select Tools/Report/Assignments to report the assignment results in journal format
• The report can be copied and pasted into an external document 

R E P O R T I N G
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• Annotations, such as arrows, 
boxes, and text, etc. can be added 
using the tools in the Main Ribbon

• The display of objects can be 
customized by right-clicking, and 
then selecting Properties

• Tables of Peaks, Integrals, 
Parameters, etc. can be opened 
by selecting View/Tables… 
Contents can be reported or 
copied to other documents

R E P O R T I N G
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• Once all page objects are laid our correctly, choose View/Layout Templates/Create Layout 
Template Document…, and save the layout file to disk

• The content of all page items is removed to leave a template with placeholders
• To use a layout template, open a new FID and/or molecular structure onto the template, and 

it will be auto-formatted to the desired size and location
• If you have a spectrum already opened, choose View/Layout Templates/Lay Out In Template 

Document… to apply a template

R E P O R T I N G
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A U T O M AT I O N / S C R I P T I N G
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• Open several 1D spectra 
in the same document

• Select some or all of 
them in the Pages view

• Press         to stack them 
in a new page

• Change the display to 
another Stack Mode, 
such as Superimposed
mode

Tip: - You can also drag a 1D from a different page using the Pages view, which adds it to the current page as a new element in 
the stack.
- When multiple pages are selected, you can choose the Superimposed tool           to superimpose them directly.
- If you want to stack all the 1D spectra from a certain folder on the computer, select Tools/Import/Directory Spectra Stack.



Right click on the spectra and select Properties/Stacked:

S TA C K E D  S P E C T R A
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Enter 0 here if you don’t 
like the tilt angle

Check here if you want to 
clip the peaks

Change colors of spectra

Click here to set 
the changes as 
default

Enlarge the top/bottom 
margins for better 3D 
effects
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S TA C K E D  S P E C T R A

• Click            to toggle on the Stacked Items table.
• Use this table to do the following: 

 Delete spectra from the stack
 Change order of the spectra in the stack
 Change the Y-intensity of selected spectra
 Choose which ones to display
 Choose which ones to adjust

To increase the vertical 
intensity of selected or 
all spectra

To decrease vertical 
intensity of selected or 
all spectra

Click and drag here to change 
the order of a spectrum in the 
stack

Uncheck the ones you want to 
hide without deleting

Check the ones that you want 
to be ‘active’

Tip: Read Help > Contents on 
more advanced data analysis, 
such as reaction monitoring, 
metabolomics, relaxation 
studies, DOSY processing, etc. 



S TA C K E D  S P E C T R A
6
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Click 
‘Adjust 
Stacked 
Items ‘  

The cursor has to be inside the blue dialogue box 
• Click and drag to shift an ‘active’ spectrum horizontally
• Click and drag to adjust the vertical offset between stacked spectra
• Reset intensities
• Reset shifts



The title shows the currently 
‘active’ spectrum

• Multiple 2D can be stacked or superimposed in the same way as 1D spectra

• Press the Shift + Up Arrow key to change the active spectrum
• Right-click on the spectrum, and select Properties to change the color of the contours for the 

active spectrum

S TA C K E D  S P E C T R A



Basic Analysis of LC/GC-MS

*You will need to have Mnova MSChrom license for this section
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• Go to File/Page Setup/Orientation and change the page orientation to portrait if you wish
• Go to Data Browser to open any file in the folder containing raw data, or drag and drop the folder 

from Windows Explorer (or Finder) into Mnova
• Mnova will automatically convert your data and pick peaks

Mass spectrum 
(at highest TIC)

TIC

Details about the compatible data format:
http://mestrelab.com/resources/ms-supported-formats/

To download the full manual of Mnova: 
https://mestrelab.com/downloads/mnova/manuals/MestReNova-
14.2.3_Manual.pdf

http://mestrelab.com/resources/ms-supported-formats/
https://mestrelab.com/downloads/mnova/manuals/MestReNova-14.2.3_Manual.pdf
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• Easily combine your MS and NMR data on the page in an Mnova document

1 2 3 4 5 6 7 8 9 10 11
Retention time (min)

0.0E+00

5.0E+07

1.0E+08

1.5E+08

2.0E+08

2.5E+08 3.686

10.6719.085
7.7694.699 9.7947.128

5.8461.425 2.9102.134

D:\Dropbox\Dro...Carvedilol.raw\ Injection 1 MS ES+ TIC

100 200 300 400 500 600 700 800 900
m/z (Da)

0.0E+00

2.0E+07

4.0E+07

6.0E+07

8.0E+07

1.0E+08

1.2E+08

1.4E+08

1.6E+08

1.8E+08 407.331

408.397

429.191

D:\Dropbox\Dro...Carvedilol.raw\ Injection 1 MS ES+ MS + spectrum 3.69
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1

O
2

3

4

5
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7

8

O
9 10
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14
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15

16
O
17
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23

24 25
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26

27

2829

30

3.03.54.04.55.05.56.06.57.07.58.08.5
f1 (ppm)

Manuel_PF-00345548-0003.18.fid
A_PROTON_WEAK CDCl3 {D:\PS} {EMEA\SRVSAN-BRUKER} 2 

28 (t)
7.33

30 (d)
8.28

26 (s)
8.14

20,27 (m)
7.40

29 (ddd)
7.23

21 (d)
7.07

4,5,6,7 (m)
6.93

19 (d)
6.70

10,14 (m)
4.29

16 (t)
4.17

1 (s)
3.84

11,13'' (m)
3.13

1.
01

3.
26

2.
79

2.
05

3.
33

0.
98

5.
17

1.
01

1.
11

0.
94

2.
35

1.
04

0.
95

3.
13

3.
14

3.
14

3.
15

3.
84

4.
16

4.
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4.
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4.
26

4.
31

6.
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6.
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6.
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6.
91

6.
92

6.
93

6.
94

6.
95

6.
95

7.
06

7.
08

7.
23

7.
33

7.
39

7.
41

7.
41

8.
27

8.
28

1

16
11,13''20,27

2128
4,5,6,7

19

10,14

30

29

13'
26

Note: When multiple spectral objects are opened they are loaded onto separate pages. You can copy (or cut) 
and paste them to the same page later.
Tip: Use the ‘Bring to Back/Front’, ‘Align’, and ‘Tile’ tools to arrange objects nicely.
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• Click           to switch to a crosshair cursor, and click 
on the TIC to display the mass spectrum at that 
retention time, or click and drag to display co-
added spectra

• Press         to change to ‘Append’ mode to add a 
mass spectrum to the display

• Choose the Crosshair/Select drop-down menu to 
display mass in different ways:

• Manual mode: Click to display a single MS, or click-and-
drag to co-add multiple MS (default)

• Peak mode: Click on a peak to display the co-added MS 
within the peak range

• Peak (Background subtraction) mode: Click on a peak to 
display the co-added MS within the peak range with the 
background subtracted

• Customized Peak mode: Customized co-added MS
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• Click          to show the MS Browser panel

• Double-click a ‘Total Absorbance’ item under ‘Traces’ to display a UV trace
• Click          to add more UV traces to the display
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• It is possible to control what to display when a dataset is first opened

• Choose File/Preferences, click the Mass icon, then the Setup tab 
• Click “+” to add plots that you want to show when a dataset is opened 

• Plots can be deleted or reordered 

This dialog sets the 
display of the first 
positive base peak 
chromatogram  (BPC) 
in the first injection 
(highlighted in the 
Preferences list) 

Tips: Use MS Browser to see components available for display.  Different preferences for different types of MS data may need 
to be defined.  Save preferences to an .ini file for later use. 
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• Choose File/Preferences, click the Mass icon, then the Setup tab  

• Define the display of the TIC, BPC, and the mass spectrum corresponding to the top four TIC 
peaks, as shown below

• Open a new MS dataset, and observe the display 
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• Double click the DAD in the MS Browser to display it

• In the New Chromatogram dialog, choose Wavelength, and enter a wavelength and a 
tolerance to display the extracted UV trace
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• Double click the DAD Trace in the MS Browser to display it
• Press         for Crosshair Cursor, press and hold the Alt key, then click on the DAD 

trace to display the UV spectrum at that retention time

In crosshair cursor 
mode, click on the 
PDA curve to display 
the UV spectrum at 
that retention time

UV spectrum

DAD 
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• Peaks are automatically integrated when you open a chromatogram

• Use the Detect Peaks ribbon icons to redetect, add, delete, or clear 
peaks 

• Hover the cursor over a blue wedge, then click and drag the green 
boxes to change the range of a peak

• Or press Shift + click and drag green boxes to change the baseline of 
a peak

• Go to View/Tables… Mass Peaks to display or report the Mass 
Peaks table 

SHIFT+
Drag
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• Click         or go to Mass Analysis/New Mass Chromatogram/Manually…

• In the New Chromatogram dialog, enter an m/z value and a suitable Tolerance
• Click OK to display the Extracted Ion Chromatogram (EIC)

EIC at 195.1 +/- 0.25 Da
Tip: You can also go to Mass 
Analysis/Spectrum Prediction to run a 
mass prediction from a molecular formula.
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• First display the MS trace and zoom into 
the molecular ion peak that you are 
interested

• Next, press         or go to Mass Analysis/ 
New Mass Chromatogram/Graphically, 
click-and-drag around the peak to define 
a mass range

• An EIC will be displayed within the mass 
range

TIC

MS at 3.08 min 

EIC at 675.3-676.2 Da
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• Import one or several structures by 
copying/pasting from ChemDraw, Isis/Draw 
or ChemSketch, or by opening .mol or .sdf 
files

• Click        or go to Mass Analysis/ Molecule 
Match/Calculate from molecules

• In the Molecule Match Table, click on a 
molecule to view the matching results

TIC

Matched Isotope 
Cluster Chromat.

Matched Isotope 
Cluster

Mol Match Results



Tip: Click the “+” buttons to add a new 
adduct.  Enter “+” for a radical cation. 
Highlight one and click the “x” button to 
remove it.  Click Restore to reset to the 
default or previously saved settings. 
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• You can go to Mass Analysis/Molecule Match/Settings to change the settings for Molecule 
Match

• The default settings are for low-resolution MS. Change Tolerance to 5-10 ppm if you are using 
high-resolution MS

• Edit the Adducts/Losses and other parameters, if required

• Click        to run the Molecule Match again
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• Align a DAD, or another trace, to a TIC using the auto-alignment settings

• Set the rules to specifically identify the instrument and apply the correct alignment 
automatically
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• This shows the curves associated with the most abundant mass peaks under the selected 
chromatogram peak



Image placeholder

This was just was just the tip of the iceberg!

For more information:

• Visit www.mestrelab.com for information about manuals, 
tutorials, and many more Mnova plugins

• Check Help > Contents in Mnova for help information
• Email support@mestrelab.com for technical questions
• Email sales@mestrelab.com for sales related queries

http://www.mestrelab.com/
mailto:support@mestrelab.com
mailto:sales@mestrelab.com
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